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Installation check list

School or Task Reference
district
O Ensure your computers and network meet the page 37

SMART Sync™ minimum requirements.

O Select a type of installation: page 2
¢ Single classroom

e School or district wide

O Install SMART Sync Class List Server. page 14

O Install SMART Sync Administrator Tool. page 16

O (Optional) Export information from third-party page 17
applications to CSV files.

O Create a SMART School (.school) file. page 19

O Install SMART Sync Teacher on teachers’ computers page 6

and SMART Sync Student on students’ computers. OR
page 27

(Optional) Configure SMART Sync Student. page 8
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Chapter 1
Getting started

Computer and network requiremMents. . . ...
Teacher and system administrator computers
Student computers
N O W OTK .

Selecting atype of installation .. ..
Single classroom installation. . ... ... ...
School- or district-wide installation.

This guide explains how to install and configure SMART Sync classroom management software.
This guide is intended for IT administrators and others experienced with installing, configuring and
administering Windows® software in a networked environment. To use this guide, you must:

e Know IT terminology such as “registry” and “domain controller”

¢ Know how to complete basic administrative tasks in Windows operating systems such as
opening the Control Panel or modifying the registry

o Have administrative privileges and access to your school’s servers

e Have the SMART Sync software CD or access to the SMART Support website

Before installing SMART Sync software, ensure your computers meet the minimum requirements
defined in this section.

H NoTE

In addition, review the recommended settings for your computers and networks on page 37.

Teacher and system administrator computers
e Pentium® Il 600 MHz processor

e 256 MB of RAM
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100 MB of free hard disk space

Windows XP, Windows Vista® or Windows 7 operating systems
800 x 600 or higher resolution display with 16-bit color quality
Internet Explorer® Internet browser 5.0 or later

DirectX® technology 7.0a or later

Student computers

Pentium [I1 500 MHz processor

128 MB of RAM

55 MB of free hard disk space

Windows XP, Windows Vista or Windows 7 operating systems
600 x 480 or higher resolution display with 16-bit color quality
Internet Explorer Internet browser 5.0 or later

DirectX technology 7.0a or later

Network
o 802.11 a/g wireless network (100 Mbps wired network or 802.11 n wireless network

recommended)

SMART Sync software consists of four components.

Component Purpose

Typical location

SMART Sync Teacher Allows teachers to connect with

students and other teachers

Teachers’ computers

SMART Sync Student Allows students to connect with

teachers

Students’ computers

SMART Sync Class List Connects teachers’ and students’
Server computers

Server accessible to all
teachers’ and students’
computers

SMART Sync Administrator Allows teachers and system

Tool

administrators to create and edit
SMART School files, which are central
repositories of student, teacher, class,
computer lab and computer
information, and application and
Internet blocking rules

Teachers’ or system
administrators’ computers
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Which of these components you install depends on whether you're implementing SMART Sync
software in a single classroom or across your school or district.

Single classroom installation
A single classroom installation includes SMART Sync Teacher and SMART Sync Student:

e The teacher creates his or her own teacher ID, classes, application blocking rules and Internet
blocking rules and manages the class with SMART Sync Teacher.

o Students connect to the teacher through SMART Sync Student by selecting the teacher’'s ID
from a drop-down list or entering the teacher computer’s host name or IP address.

See Installing SMART Sync software in a single classroom on page 5 for instructions on completing
this type of installation.

H nNoTE

Although this type of installation is preferable if you're installing SMART Sync software in a single
classroom, complete the procedures for a school- or district-wide installation if you're considering
installing SMART Sync software in other classrooms in the future.

School- or district-wide installation
A school- or district-wide installation includes all four components.

Teachers and students connect to each other thorough SMART Sync Class List Server.

Unlike in single classroom installations, in school- or district-wide installations, teacher IDs, classes,
application blocking rules and Internet blocking rules are centrally managed in SMART School files
created with SMART Sync Administrator Tool. This makes this type of installation ideal for
implementing SMART Sync software across your school or district.

See Installing SMART Sync software across a school or district on page 13 for instructions on
completing this type of installation.
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Installing SMART Sync software
In a single classroom

Installing SMART Sync Teacher and SMART Sync Student. ... ... ... ... 6
Installing SMART Sync Teacher. . ... 6
Installing SMART Sync Student. . ... .. e 7
Deploying the SMART Sync Teacher and SMART Sync Student installation packages.......... 7

Connecting students toteachers. ... il 8

Configuring SMART Sync StUdeNt. . .. 8
Running the SMART Sync Student Configuration Tool. ... . ... ... 8
Automatically configuring SMART Sync Student.......... . ... ... 12

In a typical single classroom installation, you install SMART Sync Teacher on one or more teachers’
computers and SMART Sync Student on students’ computers:

SMART Sync
Teacher

Student

SMART Sync SMART Sync SMART Sync
Student Student Student

After installation, the teacher creates his or her own class, and application and Internet blocking rules.
The students connect to the teacher by selecting the teacher’s ID from a drop-down list or entering
the teacher computer’s host name or IP address. However, you can change this if necessary by
configuring SMART Sync Student.
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If you're installing SMART Sync Teacher and SMART Sync Student on a small number of computers
or if teachers and students are responsible for installing software on their own computers, use the
installation wizards to install the software.

You can start the installation wizards by inserting the SMART Sync software CD into the computer or
downloading executable (.exe) files from the SMART website.

Installing SMART Sync Teacher

To install SMART Sync Teacher from the CD

1.

Insert the SMART Sync software CD into the teacher's computer.

The SMART Sync Classroom Management Software dialog box appears.

H nNoTE

If the dialog box doesn’t appear, browse to and open
[CD Drive\CDBrowser.exe.

Click Install Teacher Edition.

The SMART Sync Teacher installation wizard appears.
Follow the on-screen instructions.

Click Install.

Windows Installer installs SMART Sync Teacher.

To install SMART Sync Teacher from the website

1.
2.

Go to smarttech.com/software.

Browse to the SMART Sync 2010 download page, and then follow the on-screen instructions to
download the SMART Sync Teacher executable file.

Double-click the executable file.
The SMART Sync Teacher installation wizard appears.

Follow the on-screen instructions.


http://www.smarttech.com/software
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5. Click Install.

Windows Installer installs SMART Sync Teacher.

Installing SMART Sync Student

To install SMART Sync Student from the CD
1. Insert the SMART Sync software CD into the student’s computer.

The SMART Sync Classroom Management Software dialog box appears.

H nNoTE

If the dialog box doesn’t appear, browse to and open
[CD Drive\CDBrowser.exe.

2. Click Install Student Edition.

The SMART Sync Student installation wizard appears.
3. Follow the on-screen instructions.
4. Click Install.

Windows Installer installs SMART Sync Student.

To install SMART Sync Student from the website

1. Goto smarttech.com/software.

2. Browse tothe SMART Sync 2010 download page, and then follow the on-screen instructions to
download the SMART Sync Student executable file.

3. Double-click the executable file.

The SMART Sync Student installation wizard appears.
4. Follow the on-screen instructions.
5. Click Install.

Windows Installer installs SMART Sync Student.

Deploying the SMART Sync Teacher and SMART Sync Student

installation packages

If you're installing SMART Sync Teacher and SMART Sync Student on a large number of computers,
you can deploy the installation packages to the teacher's and students’ computers as documented in
Installing SMART Sync Teacher and SMART Sync Student on page 27.


http://www.smarttech.com/software
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After you install SMART Sync Teacher on the teacher's computer and SMART Sync Student on the
students’ computers, students can connect to the teacher's computer through the software.

By default, SMART Sync Student starts in visible mode when a student first logs on to his or her
computer. The student then enters his or her own ID and connects to the teacher's computer by doing
one of the following:

e Selecting the teacher’s ID from a drop-down list of teachers currently logged on to SMART
Sync Teacher if multicasting is enabled on your school’s network

o Entering the host name or IP address of the teacher's computer if multicasting isn’t enabled on
your school’s network

B T1irs

o If multicasting isn’t enabled on your school’s network and you want to allow students to
selecting the teacher’s ID from a drop-down list, install SMART Sync Class List Server (see
page 14) and connect SMART Sync Teacher and SMART Sync Student to it (see the Help).

o Teachers can determine the IP address of their computers by selecting Help > About
SMART Sync software in SMART Sync Teacher.

In some classrooms, students always connect to the same teacher or teacher computer. For these
situations, you can configure SMART Sync Student to connect to a specified teacher ID, host name
or IP address rather than requiring the student to provide this information each time he or she logs on.

For more information, see the following section.

Run the SMART Sync Student Configuration Tool to configure SMART Sync Student on a student’s
computer. The SMART Sync Student Configuration Tool updates the SyncClient.ini file on the
student’s computer, which you can then use to configure SMART Sync Student on other students’
computers without running the tool each time.

Running the SMART Sync Student Configuration Tool
If you want to configure a SMART Sync Student installation, you can run the SMART Sync Student
Configuration Tool.
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To run the SMART Sync Student Configuration Tool
1. Select Start > All Programs > SMART Technologies > SMART Sync > SMART Sync

Student Configuration Tool 2010.

The SMART Sync Student Configuration Tool appears.

2. Click Next.

In the Interface page, select one of the following options, and then click Next.

Option
Visible to students
Hidden from students

Select this option to:

Show the SMART Sync Student user interface to the student.
Hide the SMART Sync Student user interface from the student.

H nNoTE

If you click Hidden from students, the student won't be able to do the following:

o Connect to a teacher by selecting the teacher's name from a list

o Manually start SMART Sync Student
o Manually enter an ID after starting SMART Sync Student

The relevant controls in SMART Sync Student Configuration Tool will be disabled or hidden.
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4.

In the Startup page, select one of the following options:

Option

Select this option to:

Allows the student to
select from a list of
available teachers

Allow the student to select a teacher from a drop-down list using
teacher discovery.

H nNoTE

This option is disabled if you clicked Hidden from student in
step 3.

Automatically connects
with this Teacher ID

Connect SMART Sync Student to a specific teacher through the
teacher’s ID.

Type the ID in the box below the option.

Automatically connects
with this hostname or IP
address

Connect SMART Sync Student to a specific teacher through the
host name or IP address.

Type the host name or IP address in the box below the option.

H NoTE

If your network uses DHCP, refer to the computer by host
name rather than by IP address.

Automatically connects
using administered
classes

Connect SMART Sync Student to a specific teacher specified in
a SMART School file.

If you selected Allows the student to select from a list of available teachers and want to
use SMART Sync Class List Server for teacher discovery or if you selected Automatically
connects using administered classes, select the Uses this Class List Server hostname

or IP address check box.

Type the host name or IP address of the SMART Sync Class List Server computer in the box

below the check box.

H nNoTE

If your network uses DHCP, refer to the SMART Sync Class List Server computer by host
name rather than by IP address.

If the computer has multiple network adapters, click Network Adapter Selection to specify
the order of the network adapters.

Click Next.

In the Options page, clear the Start SMART Sync Student automatically check box if you
don’t want SMART Sync Student to start when the student first logs on.

H nNoTE

This check box is disabled if you selected Hidden from student in step 3.
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9. Select the check boxes for the options you want to enable, and then click Next.

Check box Select this check box to:

Ask questions Allow the student to ask questions through
SMART Sync software.

Chat Allow the student to chat with other students through
SMART Sync software.

Submit files Allow the student to submit files through SMART Sync
software.

Exit the Student program Allow the student to close SMART Sync Student.

H NoTE
These check boxes aren't visible if you clicked Hidden from student in step 3.

10. Inthe Student ID page, select one of the following options, and then click Next.

Option Select this option to:
Student Controlled Allow the student to enter an ID when SMART Sync Student
starts.
H NoTE
This option is disabled if you selected Hidden from student
in step 3.
The following Enter a specific student ID.
Type the ID in the box to the right of the option.
Found in this Find the student ID in an Active Directory® directory service
Active Directory field... field of the student’s login account.
Type the field name in the box to the right of the option.
Anonymous Allow the student to use SMART Sync Student without entering
anID.

11. Inthe Shared Files Folder page, select one of the following options, and then click Next.

Option Select this option to:

My Documents folder Store files the teacher shares with the student in the My
Documents folder (Windows XP and Windows 7) or the
Documents folder (Windows Vista).

Custom folder Store files in another folder.
Type the path to the folder in the box below the option.

11



CHAPTER 2

Installing SMART Sync software in a single classroom

12. Inthe Security page, select one of the following options, and then click Next.

Option Select this option to:

No security Allow any teacher with SMART Sync Teacher to connect to the
student.

Allow only teachers with Allow only teachers who enter a specified password in SMART

this class password Sync Teacher to connect to the student.

Type the password in the two boxes to the right of the option.

Allow only Teachers who Allow only teachers in certain groups to connect to the student.
are part of the following  Select the groups in the box below the option.
group(s)

13. Click Finish.
The Restart Required to Apply Settings message appears.
14. Click OK.

Automatically configuring SMART Sync Student

After you configure SMART Sync Student on one student’s computer using

SMART Sync Student Configuration Tool, copy the SyncClient.ini file from the student’s computer
to a central location on your network. (The SyncClient.ini file is located in
%PROGRAMFILES%\SMART Technologies\SMART Sync Student.) You can then copy the file
to other students’ computers to configure SMART Sync Student Configuration Tool automatically
without running the tool each time.

12
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In a typical school- or district-wide installation, you deploy SMART Sync Teacher to all teachers’
computers and SMART Sync Student to all students’ computers. As a system administrator, you
install SMART Sync Class List Server to connect teachers’ and students’ computers and create a
SMART School file with SMART Sync Administrator Tool to centralize teacher, student and class
information as well as application and Internet blocking rules:

B tewor [ oo

SMART Sync SMART Sync
Class List Administrator
Server Tool

Tonce
e -
SMART Sync SMART Sync
Teacher Teacher

S G G G G G
CIERIIERIERIIERIIE

SMART Sync SMART Sync SMART Sync SMART Sync SMART Sync SMART Sync
Student Student Student Student Student Student

IMPORTANT
SMART Sync Class List Server and SMART Sync Administrator Tool are beneficial tools for

centrally managing teacher, student and class information across a school or district.

Install SMART Sync Class List Server and SMART Sync Administrator Tool and create a SMART
School file before you install SMART Sync Teacher and SMART Sync Student. This allows you to
connect SMART Sync Teacher to the SMART School file and SMART Sync Student to SMART
Sync Class List Server during installation rather than having to do so manually after installation.

Installing SMART Sync Class List Server

In a typical school- or district-wide installation, you install SMART Sync Class List Server on a server
or other computer on your school’s or district’s network that all teachers’ and students’ computers can

access.

14
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To install SMART Sync Class List Server from the CD
1. Insert the SMART Sync software CD in the computer.

The SMART Sync Classroom Management Software dialog box appears.

H nNoTE

If the dialog box doesn’t appear, browse to and open
[CD Drive\CDBrowser.exe.

2. Click Install Teacher Edition.
The SMART Sync Teacher installation wizard appears.
3. Follow the on-screen instructions.

In the final step of the wizard, select the Install SMART Sync Class List Server check box
and clear the other two check boxes.

4. Click Install.

Windows Installer installs SMART Sync Class List Server.

To install SMART Sync Class List Server from the website

1. Go to www.smarttech.com/downloads.

2. Browse tothe SMART Sync 2010 download page, and then follow the on-screen instructions to
download the SMART Sync Teacher executable file.

3. Double-click the executable file.
The SMART Sync Teacher installation wizard appears.
4. Follow the on-screen instructions.

In the final step of the wizard, select the Install SMART Sync Class List Server check box
and clear the other two check boxes.

5. Click Install.

Windows Installer installs SMART Sync Class List Server.

SMART Sync Administrator Tool allows you to create SMART School files.

15
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A SMART Schooal file contains information about students, teachers, classes and computer labs in
your school as well as rules that teachers can apply to block student access to applications and
websites. If you specify the location of a SMART School file in SMART Sync Teacher, teachers can
use this information to connect to their students.

In most situations, you only need to create one SMART School file per school so that all teachers and
students in the school can connect to each other. For security reasons, when you create the file, save
it in a location accessible to teachers and system administrators, but not to students. After creating
the file, you can update it.

Installing SMART Sync Administrator Tool
In a typical school- or district-wide installation, you install SMART Sync Administrator Tool on one or
more system administrators’ computers.

To install SMART Sync Administrator Tool from the CD
1. Insert the SMART Sync software CD in the computer.

The SMART Sync Classroom Management Software dialog box appears.

H nNoTE

If the dialog box doesn’t appear, browse to and open
[CD Drive\CDBrowser.exe.

2. Click Install Teacher Edition.
The SMART Sync Teacher installation wizard appears.
3. Follow the on-screen instructions.

In the final step of the wizard, select the Install SMART Sync Administrator Tool check box
and clear the other two check boxes.

4. Click Install.

Windows Installer installs SMART Sync Administrator Tool.

To install SMART Sync Administrator Tool from the website

1. Go to www.smarttech.com/downloads.

2. Browse tothe SMART Sync 2010 download page, and then follow the on-screen instructions to
download the SMART Sync Teacher executable file.

3. Double-click the executable file.

The SMART Sync Teacher installation wizard appears.

16
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4. Follow the on-screen instructions.

In the final step of the wizard, select the Install SMART Sync Administrator Tool check box
and clear the other two check boxes.

5. Click Install.
Windows Installer installs SMART Sync Administrator Tool.

Using information from third-party applications
If you manage school information using a third-party application, you might be able to export the
school information to a Comma Separated Values (CSV) file to use it in your SMART School file.

The information that the CSV file contains depends on how computers are used in your school.

Creating a CSV file for schools with individual computers
If each student has his or her own laptop or assigned computer in a class, create a CSV file that

contains student, teacher and class information:

PersonlID, LastName,FirstName,Title,ClassID,ClassTitle, Type
5001, Adams, John, ,Eng,English, 0
5002,Brook, Sally, ,Eng,English, 0

5003,Williams,Ronald, ,Eng,English, 0O

T001l, Johnson, Adam,Mr.,Eng,English,1

IMPORTANT

If a teacher or student is in multiple classes, the CSV file must contain multiple lines for that
teacher or student (one for each class).

To create a student, teacher and class CSV file

1. Export student, teacher and class information from the third-party application to a CSV file.

B NoTE
See the third-party application’s Help for instructions.

2. Openthe CSV file using Excel® or another application that can open CSV files.

17
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3. Ensure the CSV file contains the following columns:

Column Type Description
name
PersonID String The student’s or teacher’s unique ID
IMPORTANT
© The ID you enter here must match the ID the student uses
tolog on to SMART Sync Student.
© The ID must be unique to the student or teacher. For
example, a student and a teacher can’t both have the ID
123456.
LastName  String The student’s or teacher’s last name
FirstName  String The student’s or teacher’s first name
Title String The teacher's title (for example, Mr., Ms. or Dr.)
H NoTE
SMART Sync Administrator Tool only stores this information for
teachers.
ClassID String The unique ID of the student’s or teacher’s class
ClassTitle  String The name of the student’s or teacher’s class.
If appropriate, include the class’s period to distinguish it from other
classes.
Type Integer 0 for a student
OR
1 for a teacher
H NoTESs

o The first row of the spreadsheet must contain the column names as listed in the table

above.

o The string columns can contain any character except a comma (,).

4. Savethe CSV file.

Creating a CSV file for schools with computer labs
If your school's computers are located in labs, create a CSV file that contains computer lab
information:

Hostname,Workstation Name,Lab ID,Lab Title

127.
127.
127.
127.

18

0.0.1,Main
0.0.2,Main
0.0.3,Main
0.0

.4,Main

Lab
Lab
Lab
Lab

WS1,Main,Main Lab
WS2,Main,Main Lab
WS3,Main,Main Lab
WS4,Main,Main Lab
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127.0.0.5,Main Lab WS5,Main,Main Lab

To create a computer lab CSV file

1. Export computer lab information from the third-party application to a CSV file.
K NoTE
See the third-party application’s Help for instructions.

2. Openthe CSV file using Excel or another application that can open CSV files.

3. Ensure the CSV file contains the following columns:

Column name Type Description
Hostname String The computer's host name or IP address (for example,
127.0.0.1)
H NoTE

If your network uses DHCP, refer to the computer by
host name rather than by IP address.

Workstation Name String The computer's name

LabID String The unique ID of the computer’s lab
Lab Title String The name of the computer’s lab

Kl NOTEs

o The first row of the spreadsheet must contain the column names as listed in the table
above.

o The string columns can contain any character except a comma ().

4. Savethe CSV file.

Creating a SMART School file

After installing SMART Sync Administrator Tool and exporting information from third-party

applications to CSV files, you can use SMART Sync Administrator Tool to create a SMART School
file.

Starting SMART Sync Administrator Tool
The first step in creating a SMART School file is to start SMART Sync Administrator Tool.

To create a SMART School file
1. Double-click the SMART Sync Administrator Tool 2010 icon on your desktop.
The SMART Sync Administrator Tool window appears.

19
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Click School File.

Click Create a new SMART School file and save it as.
Click Browse.

The Select School File Location dialog box appears.

Browse to the folder where you want to create the SMART School file.

IMPORTANT

For security reasons, create the SMART School file in a location that is accessible to
teachers and system administrators but not to students. Teacher can have read-only access
to the file, but system administrators require read/write access.

Type a name in the File name box.
Click Save.

The Select School File Location dialog box closes, and the path to the SMART School file
appears in the box below the Create a new SMART School file and save it as option.

Locating SMART Sync Class List Server
You must enter the host name or IP address of the computer hosting SMART Sync Class List Server

in the SMART School file.

To locate SMART Sync Class List Server

20

1.

Start SMART Sync Administrator Tool (see Starting SMART Sync Administrator Tool on the
previous page).

Click Class List Server.
Type the host name or IP address of the computer hosting SMART Sync Class List Serverin
the Enter the IP address or hostname of your Class List Server box.

B NOTES

o SMART Sync Class List Server uses port number 46200 by default. However, you can
change the port number. If you do so, you must include the port number after the host
name or IP address (for example, 127.0.0.1:46201).

o If your network uses DHCP, refer to the SMART Sync Class List Server computer by
host name rather than by IP address.

4. Click Test Connection to test the connection to the SMART Sync Class List Server

compulter.
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Importing school information

You can manually enter student, teacher and class or computer lab information in SMART School
files using SMART Sync Administrator Tool. Alternatively, you can import this information from a
CSV file generated from a third-party application (see Using information from third-party applications
on page 17).

To import student, teacher and class information

1.

Start SMART Sync Administrator Tool (see Starting SMART Sync Administrator Tool on page
19).

Click Import Information.

Click Browse to the right of the Student, Teacher, Class CSV file Location box.
The Open Classes CSV File dialog box appears.

Navigate to and select a student, teacher and class CSV file.

Click Open.

The Open Classes CSV File dialog box closes, and the path to the CSV file appears in the
Student, Teacher, Class CSV file Location box.

To import computer lab information

1.

Start SMART Sync Administrator Tool (see Starting SMART Sync Administrator Tool on page
19).

Click Import Information.

Click Browse to the right of the Computer, Lab CSV File Location box.
The Open Labs CSV File dialog box appears.

Navigate to and select a computerlab CSV file.

Click Open.

The Open Labs CSV File dialog box closes, and the path to the CSV file appears in the
Computer, Lab CSV File Location box.

Entering student information

You can import student information from a CSV file (see Importing school information above).
Alternatively, you can manually enter student information in a SMART School file using SMART
Sync Administrator Tool.
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NOTE

Student information is required only if you're entering classes in the SMART School file (see
Entering class or computer lab information on the next page).

To add a student

1.

Start SMART Sync Administrator Tool (see Starting SMART Sync Administrator Tool on page
19).

Click Students.

Click Add Student.

A new row appears in the table.

Type the student’s last name in the Last Name column.
Type the student’s first name in the First Name column.

Type the student’s ID in the Student ID column.

IMPORTANT

The ID you enter here must match the ID the student uses to log on to SMART Sync
Student.

B NoTE

SMART Sync Administrator Tool generates a random ID for the student if you don’t specify
one.

Entering teacher information

You can import teacher information from a CSV file (see Importing school information on the previous
page). Alternatively, you can manually enter teacher information in a SMART School file using
SMART Sync Administrator Tool.

H nNoTE

Teacher information is required only if you're entering classes in the SMART School file (see

Entering class or computer lab information on the next page).

To add a teacher

1.
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2. Click Teachers.
3. Click Add Teacher.
A new row appears in the table.
4. Type the teacher’s last name in the Last Name column.
5. Type the teacher's first name in the First Name column.
6. Type the teacher’s title in the Title column (for example, Mr., Ms. or Dr.).

Entering class or computer lab information
If each student has his or her own laptop or assigned computer in a class, you must enter classes in

the SMART School file.

OR

If computers are located in labs in your school, you must enter the labs in the SMART School file.
You can import class or computer lab information from a CSV file (see Importing school information

on page 21). Alternatively, you can manually enter class or computer lab information ina SMART
School file using the Classes section or Computer Labs section of SMART Sync Administrator Tool.

To add a class

1. Start SMART Sync Administrator Tool (see Starting SMART Sync Administrator Tool on page
19).

2. Click Classes.
3. Click Add.
A new row appears in the table.
4. Type aname in the Class Name column (for example, 5th Grade Math).
If appropriate, include the class’s period to distinguish it from other classes.
5. Select the name of a teacher or student you want to include in the class in the

All Students and Teachers list, and then click E to move it to the Class Members list.

H NOTES

o Inthe All Students and Teachers and Class Members lists, teachers’ names appear in
red text and students’ names appear in black text.

o Toremove teachers or students from a class, select their names in the Class

Members list, and then click E to move them to the
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Repeat step 5 for each teacher or student that you want to add to the class.

To add a computer lab

1.

Start SMART Sync Administrator Tool (see Starting SMART Sync Administrator Tool on page
19).

Click Computer Labs.

Click Add.

A new row appears in the computer lab table.

Type a name in the Lab Name column (for example, Main Lab).
Click Add Computer.

A new row appears in the computer table.

Type the host name or IP address of the computer in the Hostname column (for example,
127.0.0.1).

H NoTE
If your network uses DHCP, refer to the computer by host name rather than by IP address.

Type the name of the computer in the Workstation Name column (for example,
Main Lab WS1).

Repeat steps 5 to 7 for each computer you want to add to the computer lab.

H nNoTE

To remove a computer from the computer lab, select the computer, and then click Remove
Computer.

Creating administered application blocking rules

An application blocking rule allows teachers either to allow specific applications and block all others
or to block specific applications and allow all others. For example, an English teacher could allow
access to Microsoft® Word but block access to all other applications during the writing of an English

paper.

Teachers can individually create and share application blocking rules in SMART Sync Teacher.
Alternatively, you can create centrally administered application blocking rules and include themin a
SMART School file.
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To create a rule

1.

10.

Start SMART Sync Administrator Tool (see Starting SMART Sync Administrator Tool on page
19).

Click Application Blocking.

Click Add.

A new row appears in the application blocking rule table.

Type a name in the Rule Name column (for example, English Paper).

Select Block all applications except those listed below to block all applications except
those you include in the rule.

OR

Select Allow all applications except those listed below to allow all applications except
those you include in the rule.

Click Add Application.

The Select Application dialog box appears.

Navigate to and select the application’s executable (.exe) file.

Click Open.

The Select Application dialog box closes, and a new row appears in the application table.

Type a name for the application in the Display Name column if you don’t want to use the default
name.

Repeat steps 6 to 9 or each application you want to add to the application blocking rule.

H nNoTE

To remove an application from the application blocking rule, select the application, and then
click Remove Application.

Creating administered Internet blocking rules

An Internet blocking rule allows teachers either to allow specific websites and block all others or to
block specific websites and allow all others. For example, a history teacher could block access to
online encyclopedias and other history resources during the writing of a history paper.

Teachers can individually create and share Internet blocking rules in SMART Sync Teacher.
Alternatively, you can create centrally administered Internet blocking rules and include them in a
SMART School file.
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To create a rule

1.

Start SMART Sync Administrator Tool (see Starting SMART Sync Administrator Tool on page
19).

Click Internet Blocking.

Click Add.

A new row appears in the Internet blocking rule table.

Type a name in the Rule Name column (for example, History Paper).

Select Block all websites except those listed below to block all websites except those you
include in the rule.

OR

Select Allow all websites except those listed below to allow all websites except those you
include in the rule.

Click Add Website.
A new row appears in the website table.

Type the address of the website in the Website Address column (for example,
www.example.com).

Repeat steps 6 to 7 for each website you want to add to the Internet blocking rule.

H nNoTE

To remove a website from the Internet blocking rule, select the website, and then click
Remove Website.

Reviewing the SMART School file
After creating a SMART School file, you can review it in the Summary section and then close
SMART Sync Administrator Tool to save the file. You should complete the following tasks before

reviewing and saving the file:

e Locate SMART Sync Class List Server (see Locating SMART Sync Class List Server on page
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¢ Import school information (see Importing school information on page 21).

OR

Enter student, teacher or class information (see Entering student information on page 21,
Entering teacher information on page 22, and Entering class or computer lab information on
page 23).

OR
Enter computer lab information (see Entering class or computer lab information on page 23).

Create administered application blocking rules (see Creating administered application blocking
rules on page 24).

Create administered Internet blocking rules (see Creating administered Internet blocking rules
on page 25).

To review the SMART School file

1.

Start SMART Sync Administrator Tool (see Starting SMART Sync Administrator Tool on page
19).

Click Summary.
If any warnings appear, read them and take the appropriate actions.

Click Exit.

After installing SMART Sync Class List Server and SMART Sync Administrator Tool and creating a
SMART School file, you can install SMART Sync Teacher on teachers’ computers and SMART Sync
Student on students’ computers.

Installing SMART Sync Teacher and SMART Sync Student across a school or district involves three

steps:
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Locating the installation files
The first step in installing SMART Sync Teacher and SMART Sync Student across a school or
district is to locate the installation packages and supporting files.

Locating the installation packages
There are two installation packages (also known as MSI files) for SMART Sync software:

Installation package File name Components
SMART Sync Teacher SMART Sync SMART Sync Teacher, SMART Sync Class List
2010.msi Server and SMART Sync Administrator Tool
SMART Sync Student SMART Sync SMART Sync Student
Student.msi

Both installation packages are located on the SMART Sync software CD. The SMART Sync Teacher
installation package is located in the TeacherSetup folder, and the SMART Sync Student installation
package is located in the StudentSetup folder.

Alternatively, you can download both packages from www.smarttech.com/downloads.

Save the packages in alocation on your school’s network that is accessible to all computers on
which you plan to install SMART Sync software.
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Locating the language files

If you plan to deploy the SMART Sync software installation packages in a language other than
English (U.S.), ensure the corresponding MST file for that language is in the same folder as the MSI
file.

Language Code File

English (U.S.) 1033 1033.mst
English (UK) 2057 2057.mst
Arabic 1025 1025.mst
Chinese (Simplified) 2052 2052.mst
Czech 1029 1029.mst
Danish 1030 1030.mst
Dutch 1043 1043.mst
Finnish 1035 1035.mst
French (France) 1036 1036.mst
French (Canada) 3084 3084.mst
German 1031 1031.mst
Greek 1032 1032.mst
Hebrew 1037 1037.mst
Hungarian 1038 1038.mst
Italian 1040 1040.mst
Norwegian 1044 1044.mst
Polish 1045 1045.mst
Portuguese (Portugal) 2070 2070.mst
Portuguese (Brazil) 1046 1046.mst
Russian 1049 1049.mst
Slovak 1051 1051.mst
Slovenian 1060 1060.mst
Spanish (Spain) 1034 1034.mst
Spanish (Mexico) 2058 2058.mst
Swedish 1053 1053.mst
Turkish 1055 1055.mst

The language files are available from the same locations as the SMART Sync installation packages.

Customizing the installation packages
After locating the installation packages, you can customize them by creating MST files.
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IMPORTANT

If you installed SMART Sync Class List Server and SMART Sync Administrator Tool and created a
SMART School file, customize the SMART Sync Teacher installation package to reference the
SMART School file location and the SMART Sync Student installation package to reference the
SMART Sync Class List Server location.

You can create MST files using SMART Install Manager (see page 47) or a third-party tool such as
Orca database editor and the Windows Installer properties (see Windows Installer reference on page
39).

Deploying the installation packages

The final step in installing SMART Sync Teacher and SMART Sync Student is to deploy the
installation packages. You can do this using the command line interface, or third-party imaging or
remote management software.

Using the command line interface

Using the command line interface, you can deploy the SMART Sync Teacher and SMART Sync
Student installation packages in many ways, including running commands from the Command
Prompt window and including commands in batch script files.

To install SMART Sync Teacher

Run the following command if you created an MST file to customize the installation package:

msiexec /i " [Path]J\SMART Sync 2010.msi" TRANSFORMS="[MST File]"

[Parameter]
OR
Run the following command if you didn’t create an MST file to customize the installation package:
msiexec /i " [Path]J\SMART Sync 2010.msi" [Properties] [Parameter]
Where
e [Path]is the path to the SMART Sync 2010.msi file and MST file.

e MST File is the name of the MST file.

e Properties is a set of properties you can include to customize the installation (see SMART
Sync Teacher installation package on page 39).
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IMPORTANT
If you installed SMART Sync Class List Server and SMART Sync Administrator Tool and
created a SMART School file, include the SCHOOLFILE property.

e [Parameter] is the installation parameter (see Parameters on page 45).

To install SMART Sync Student

Run the following command if you created an MST file to customize the installation package:

msiexec /i " [Path]J\SMART Sync Student.msi" TRANSFORMS="[MST File]"
[Parameter]
OR

Run the following command if you didn’t create an MST file to customize the installation package:

msiexec /1 "[Path]J\SMART Sync Student.msi" [Properties] [Parameter]

Where
e [Path]is the path to the SMART Sync 2010.msi file and MST file.
e MST File is the name of the MST file.

o Properties is a set of properties you can include to customize the installation (see SMART
Sync Teacher installation package on page 39).

IMPORTANT

If you installed SMART Sync Class List Server and SMART Sync Administrator Tool and
created a SMART School file, include the
SYNC_NAMINGSERVERLOC property.

e [Parameter] is the installation parameter (see Parameters on page 45).

Using third-party imaging or remote management software

The following procedure shows how to deploy SMART Sync software using Windows operating
systems’ Group Policy-based deployment software. For information on deploying SMART Sync
software using your organization’s third-party imaging or remote management software, see the
software’s documentation.
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H nNoTE

This procedure may vary depending on your version of Windows operating system and your system
preferences.

To deploy an installation package

1. Copy the MSI file and the MST file to \\[Domain ControllerANETLOGON, where [Domain
Controller] is your school’s domain controller.

2. Open the Control Panel.
3. Double-click Administrative Tools.
4. Double-click Active Directory Users and Computers.
The Active Directory Users and Computers window appears.
5. Right-click your school’s domain, and then select Properties.
The Properties dialog box appears.
6. Click the Group Policy tab, and then click Edit.
The Group Policy Object Editor dialog box appears.
7. Browse to and open Computer Configuration\Software Settings.
8. Right-click Software Installation, and then select New > Package.
9. Browse to and select the MSI file from step 1.
10. Inthe Deploy Software section, click Advanced, and then click OK.
11. Click the Modifications tab, and then click Add.
12. Browse to and select the MST file from step 1.
13. Click OK to apply the MST file to the MSI file.
14. Close all open windows and dialog boxes.

The next time each computer on the domain starts, it automatically installs the software in
Silent mode with the customizations defined in the MST file.
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After installing SMART Sync software, you may need to modify it or remove it. You can use the same
tools you used to install SMART Sync software to modify or remove it.

Using the SMART Sync Teacher and SMART Sync Student installation packages (see page 28), you
can complete the following tasks using the command line interface:

¢ Adding or removing SMART Sync Teacher components
¢ Removing SMART Sync Teacher
¢ Removing SMART Sync Student

Adding or removing SMART Sync Teacher components

After installing the SMART Sync Teacher on a computer, you may decide to add or remove
components. For example, you may have installed SMART Sync Teacher on the same computer you
now want to install SMART Sync Class List Server and SMART Sync Administrator Tool on.

To add a component

Run the following command:

msiexec /i " [Path]\SMART Sync 2010.msi" [Remove properties] /q

Where:
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e [Path]is the path to the SMART Sync 2010.msi file.

e [Remove properties] is the set of properties for the component you want to remove:

Components Add Properties

SMART Sync INSTALLTEACHER="" REINSTALLMODE=voums

Teacher REMOVE=Teacher

SMART Sync Class INSTALLCLASSLISTSERVER="" REINSTALLMODE=voums
List Server REMOVE=ClassListServer

SMART Sync INSTALLADMINTOOL="" REINSTALLMODE=voums
Administrator Tool REMOVE=AdminTool

See page 35 for examples.

To remove a component

Run the following command:

msiexec /i " [Path]J\SMART Sync 2010.msi" [Installation properties] [Add
properties] /q

Where:
e [Path]is the path to the SMART Sync 2010.msi file.

o [Installation properties] are the INSTALL properties of the components already installed.

B Tip

If SMART Sync Teacher is already installed, you don’t need to include the
INSTALLTEACHER property, as it's enabled by default.

o [Add properties] is the set of properties for the component you want to add:

Components Add Properties

SMART Sync INSTALLTEACHER="1" REINSTALLMODE=voums

Teacher ADDLOCAL=Teacher

SMART Sync Class INSTALLCLASSLISTSERVER="1" REINSTALLMODE=voums
List Server ADDLOCAL=ClassListServer

SMART Sync INSTALLADMINTOOL="1" REINSTALLMODE=voums
Administrator Tool ADDLOCAL=AdminTool

See page 35 for examples.
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Component addition examples
The following example installs SMART Sync Administrator Tool on a computer that already has
SMART Sync Teacher (but not SMART Sync Class List Server):

msiexec /i "D:\TeacherSetup\SMART Sync 2010.msi" INSTALLADMINTOOL=1
REINSTALLMODE=voums ADDLOCAL=AdminTools /gb

The following example installs SMART Sync Teacher on a computer that already has SMART Sync
Administrator Tool (but not SMART Sync Class List Server):

msiexec /i "D:\TeacherSetup\SMART Sync 2010.msi" INSTALLADMINTOOL=1
INSTALLTEACHER=1 REINSTALLMODE=voums ADDLOCAL=Teacher /gb

The following example installs SMART Sync Class List Server on a computer that already has
SMART Sync Teacher and SMART Sync Administrator Tool:

msiexec /i "D:\TeacherSetup\SMART Sync 2010.msi" INSTALLADMINTOOL=1
INSTALLCLASSLISTSERVER=1 REINSTALLMODE=voums ADDLOCAL=ClassListServer
/qb

Component removal examples
The following example removes SMART Sync Administrator Tool:

msiexec /i "D:\TeacherSetup\SMART Sync 2010.msi" INSTALLADMINTOOL=""
REINSTALLMODE=voums REMOVE=AdminTools /gb

Removing SMART Sync Teacher and SMART Sync Student

To remove SMART Sync Teacher

Run the following command:

msiexec /x " [Path]\SMART Sync 2010.msi" /g

To remove SMART Sync Student

Run the following command:

msiexec /x " [Path]\SMART Sync Student.msi" /g
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The following procedure shows how to remove SMART Sync software using Windows operating
systems’ Group Policy-based deployment software. For information on removing software using your
organization’s third-party imaging or remote management software, see the software’s
documentation.

NOTE

This procedure may vary depending on your version of Windows operating system and your system
preferences.

To remove a deployed installation package

1.
2.
3.
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Open the Control Panel.

Double-click Administrative Tools.

Double-click Active Directory Users and Computers.

The Active Directory Users and Computers window appears.
Right-click your school’s domain, and then select Properties.
The Properties dialog box appears.

Click the Group Policy tab, and then click Edit.

The Group Policy Object Editor dialog box appears.

Browse to and open Computer Configuration\Software Settings\
Software Installation.

Right-click the software you want to remove, and then select All Tasks > Remove.
Select Immediately uninstall the software from users and computers, and then click OK.

The next time each computer on the domain starts, it automatically removes the software.
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Before installing SMART Sync software, configure your computers and network for optimal
performance as documented in this appendix.

SMART Sync software works best when the teachers’ and students’ computers are set to the same
screen resolution and color depth. However, the software makes adjustments for different color
settings and resolutions. For example, if a broadcasting computer (either teacher or student) runs at a
higher resolution than a viewing computer, scroll bars appear on the viewing computer so you can
view the entire higher-resolution screen.

Similarly, if a broadcasting computer has a higher color setting than a viewing computer, the
broadcasting computer’'s colors are reduced so the user can see it at the viewing computer. For
example, if a student’s computer has a higher color setting than the teacher's computer, the teacher
sees a Color Reduced message below the thumbnail. When the teacher views a live, full-screen
image, the colors appear slightly degraded.

For information on how to change the display settings of your school’s monitors, see the instructions
that came with the operating system.

SMART Sync software works best when the screen resolution is 1024 x 768. Refer to the following
table for the optimal screen resolution and color depth for your school’s monitors.

Color depth/screen resolution High color (16-bit) True color (32-bit)
1024 x 768 or lower Optimal Optimal

1152 x 864 Acceptable Acceptable

1280 x 1024 Acceptable Acceptable

1600 x 1200 Acceptable Not recommended
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The preferred TCP/IP network configuration for SMART Sync software is a switch or a switching hub
that restricts network traffic to a particular segment of your local area network. In this configuration,
other network traffic doesn’t affect your system and SMART Sync software doesn’t slow down other

segments of the network. Network activity is faster when the number of connected students is
smaller.

Network type Maximum number of students
100 Mbps 80

Wireless (single 802.11 a/g access point) 30

Wireless (single 802.11 n access point) 35

B Tip

Graphics-rich backgrounds on your students’ screens can slow SMART Sync software
performance. Performance is best if your students’ screens have simple, single-color backgrounds.

If you install SMART Sync software on a computer that has an active Internet connection firewall, the
firewall can cause network problems. If possible, set the firewall to allow network traffic from

SMART Sync software. If this doesn’t resolve the problem, ensure the following network
communication ports are open:

Port Type Purpose

5463 TCP Main teacher to student communications port
5485 TCP Main teacher to teacher communications port
5496 UubDP Teacher discovery port

5491 UDP Broadcast port

5493 UubDP Broadcast recovery port

46200 TCP SMART Sync Class List Server
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The SMART Sync software installation packages contain all of the information that Windows Installer
requires to install or remove the SMART Sync software components. Run the MSI files from a
command prompt to start Windows Installer and install or modify the software using available
properties and parameters.

SMART Sync Teacher installation package

The following are properties for the SMART Sync Teacher installation package:

Property Values Notes

General properties

INSTALLDIR [String]: The path to your preferred folder for  If you don’t include this
SMART Sync Teacher. property, Windows Installer
installs SMART Sync Teacher
in %PROGRAMFILES%\
SMART Technologies\
SMART Sync 2010.

ISX_ [String]: The 22-character product key you
SERIALNUM received from SMART.
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Property Values

Notes

TRANSFORMS [String]: A language MST file for the
installation (see Locating the language files on
page 29).

Ensure the specified MST file is
in the same folder as the MSI
file.

This property defines the
language of the installer’s user
interface and the installed
software’s icons and shortcuts.
It doesn’t define the installed
software’s user interface
language. The installed
software uses the computer’s
operating system language if
it’s supported, or English (U.S.)
if not.

SMART Sync Teacher properties

INSTALL 1 (default): Install SMART Sync Teacher.
TEACHER [Null]: Don’tinstall SMART Sync Teacher.
INSTALL 1: Install SMART Sync Class List Server.
CLASSLIST [Null] (default): Don’t install SMART Sync
SERVER Class List Server.

INSTALL 1: Install SMART Sync Administrator Tool.

ADMINTOOL  [Null] (default): Don’t install SMART Sync
Administrator Tool.

SCHOOLFILE [String]: The path to the SMART School file.

Before you can specify the path
to a SMART School file, you
must install SMART Sync
Administrator Tool, and then
use it to create the SMART
School file.

SMART Product Update properties

INSTALL_SPU 1: Install SMART Product Update.

[Null] (default): Don’t install SMART Product
Update.

SMART Product Update
doesn’t check for updates to
SMART Sync software.
However, it does check for
updates to other installed
SMART products.
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Property Values

Notes

SPU_TIME_ [Integer]: The time in days between SMART
FRAME Product Update checks.

By default, SMART Product
Update checks for product
updates every 30 days. You
can set it to check for product
updates at intervals of one to 60
days.

This property is only applicable
if you install SMART Product
Update.

PRODUCT_ 1 (default): Notify the user when updates are
NOTIFICATION available from SMART Product Update.

[Null]: Don’t notify the user when updates are
available from SMART Product Update.

This property is only applicable
if you install SMART Product
Update.

SMART Sync Student installation package

The following are properties for the SMART Sync Student installation package:

Property Values

Notes

General properties

INSTALLDIR [String]: The path to your preferred folder for
SMART Sync Student.

If you don’t include this
property, Windows Installer
installs SMART Sync Student
in %PROGRAMFILES%\
SMART Technologies\
SMART Sync Student.

TRANSFORMS [String]: A language MST file for the
installation (see Locating the language files on
page 29).

Ensure the specified MST file is
in the same folder as the MSI
file.

This property defines the
language of the installer’'s user
interface and the installed
software’s icons and shortcuts.
It doesn’t define the installed
software’s user interface
language. The installed
software uses the computer’s
operating system language if
it's supported, or English (U.S.)
if not.
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Property

Values

Notes

LOCALE

[Integer]: A language code for SMART Sync
Student (see Locating the language files on
page 29).

If you don’t specify a language
code using LOCALE, SMART
Sync Student uses the
computer’s operating system
language if it's supported, or
English (U.S.) if not.

SMART Sync Student properties

CREATE_ 1 (default): Include shortcuts to SMART Sync
SHORTCUTS Student in the Start menu and on the desktop.
[Null]: Don’t include shortcuts to SMART
Sync Student in the Start menu and on the
desktop.
PATHTOINI [String]: The full path and file name for the If you've previously installed

SyncClient.ini file.

SMART Sync Student, you can
run the SMART Sync Student
Configuration Tool to create a
SyncClient.ini file, which you
can then refer to in this
property.

If you don’t include this
property, you can configure
SMART Sync Student using
the SYNC_* properties
described below.

If you don’t include this property
or the SYNC_* properties,
Windows Installer refers to the
SyncClient.ini file in the same
folder as the MSI file. If
Windows Installer can’t find a
SyncClient.ini file in this
folder, it uses a default
SyncClient.ini file.

SYNC_VISIBLE 1 (default): Show the SMART Sync Student

user interface.

0: Hide the SMART Sync Student user
interface.
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Property

Values

Notes

SYNC_
CONTEACHID

[String]: A teacher ID to which SMART Sync
Student will connect automatically.

If you set SYNC_VISIBLE to 0,
you must include this property,
SYNC_CONNECTIP or
SYNC_
NAMINGSERVERLOC.

If you include this property,
don’tinclude SYNC_
CONNECTIP and SYNC_
NAMINGSERVERLOC.

SYNC_
CONNECTIP

[String]: A teacher host name or IP address to
which SMART Sync Student will connect

automatically.

If you set SYNC_VISIBLE to 0,
you must include this property,
SYNC_CONTEACHID or
SYNC_
NAMINGSERVERLOC.

If you include this property,
don’tinclude SYNC_
CONTEACHID and SYNC _
NAMINGSERVERLOC.

SYNC_NAMING
SERVERLOC

[String]: A SMART Sync Class List Server
host name or IP address to which SMART
Sync Student will connect automatically.

If you set SYNC_VISIBLE to 0,
you must include this property,
SYNC_CONTEACHID or
SYNC_CONNECTIP.

If you include this property,
don’tinclude SYNC_
CONTEACHID and SYNC _
CONNECTIP.

SYNC_
AUTOSTART

1 (default): Start SMART Sync Student when

the student first logs on.

0: Don’t start SMART Sync Student when the

student first logs on.

This property is only applicable
if youset SYNC_VISIBLE to 1.

SYNC_ENABLE
QUESTIONS

1 (default): Allow the student to ask questions

through SMART Sync Student.

0: Don'’t allow the student to ask questions

through SMART Sync Student.

This property is only applicable
if you set SYNC_VISIBLE to 1.

SYNC_
ENABLECHAT

1 (default): Allow the student to chat with other
students through SMART Sync Student.

0: Don't allow the student to chat with other
students through SMART Sync Student.

This property is only applicable
if youset SYNC_VISIBLE to 1.

SYNC_
ENABLEFILE
TRANSFER

1 (default): Allow the student to submit files

through SMART Sync Student.

0: Don't allow the student to submit files

through SMART Sync Student.

This property is only applicable
if you set SYNC_VISIBLE to 1.
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Property Values Notes

SYNC_ 1: Allow the student to close SMART Sync This property is only applicable

DISPLAYEXIT  Student. if you set SYNC_VISIBLE to 1.
0: Don’t allow the student to close SMART
Sync Student.

SYNC_ 0: Use a student ID found in an Active If youset SYNC_VISIBLE to 1,

STUDIDMODE Directory field specified in SYNC_ this property’s default value is
ACTDIRSTUDID. 2.
1: Use a student ID specifiedin SYNC _ If you set SYNC_VISIBLE to 0,
STUDENTID. this property’s default value is
2: Allow the student to enter an ID when 1. In this situation, you must
SMART Sync Student starts. include SYNC_STUDENTID.
3: Allow the student to use SMART Sync
Student without entering an ID.

SYNC_ [String]: The name or ID of an Activity If you include this property,

ACTDIRSTUDID

Directory field that contains the student’s ID.

SYNC_STUDIDMODE is set
to 0 automatically.

SYNC_
STUDENTID

[String]: A student ID.

If you include this property,
SYNC_STUDIDMODE is set
to 1 automatically.

SYNC_
CUSTSHRD
FOLDER

[Null] (default): Store files the teacher shares
with the student in the My Documents folder
(Windows XP and Windows 7) or Documents

folder (Windows Vista).

[String]: Store files the teacher shares with
the student in another folder specified in this
property.
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The following are the standard Windows Installer parameters:

Parameter Use
Iq Hide the installation wizard.
H NoTE
This is Silent mode.
Igb Show a basic installation wizard.
/gb! Show a basic installation wizard without a Cancel button.
Iqb+ Show a basic installation wizard with a dialog box signaling the end of the
installation.
/gb+! Show a basic installation wizard without a Cancel button but with a dialog box
signaling the end of the installation.
Iqr Show a reduced installation wizard.
Iqf Show the full installation wizard, including a dialog box signaling the end of the
installation or the Fatal Error, User Exit or Exit dialog box.
Iqn Hide the installation wizard and the dialog box signaling the end of the
installation.
Iqn+ Hide the installation wizard but show the dialog box signaling the end of the
installation.
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SMART Install Manager allows you to customize SMART software installation packages (also
known as MSI files) by publishing MST files. You can then install the MSI and MST files on
computers using third-party imaging or remote management software.

You caninstall SMART Install Manager from the included CD.
OR
You can download and install SMART Install Manager from the SMART Support website.

To install the software from the CD

1. Insert the CD in your computer's CD drive. A dialog box appears.

H NoTE

If the dialog box doesn’t appear, browse to and open
[CD Drive\CDBrowser.exe in Windows Explorer.

2. Click Administrator Preparation and Tools, and then click Install
SMART Install Manager.

The SMART Install Manager installation wizard appears.
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3. Follow the on-screen instructions.
4. Click Install.

Windows Installer installs SMART Install Manager.

To install the software from the website

1. Goto smarttech.com/software.

2. Browse to the appropriate download page, and then follow the on-screen instructions to
download the Install Manager.exe executable file.

3. Double-click the Install Manager.exe file.

The SMART Install Manager installation wizard appears.
4. Follow the on-screen instructions.
5. Click Install.

Windows Installer installs SMART Install Manager.

After you install SMART Install Manager, shortcuts to the software appear on the desktop and in the
Start menu under All Programs > SMART Technologies > SMART Install Manager.
With SMART Install Manager, you can do the following:

e Open an installation package.

e Save your changes to the installation package.

o Publish your changes to the installation packages as an MST file.

Opening an installation package
To customize an installation package, open its MSI file in SMART Install Manager by doing one of the
following:

e Select File > Open.

e Click =¥
o Dragthe MSI file into the SMART Install Manager window.

Alternatively, you can search for installation packages on your computer by clicking o] ,oronCDs or
DVDs by clicking .
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B 1ip

Allinstallation packages you've previously opened in SMART Install Manager appear in the
Unmodified Packages tab.

After you open an installation package, a set of pages for that installation package appear in
SMART Install Manager.

[l 5B bt Manisger= SMART Symc Teacher 2010 - Untitied =

Wrkams Installation Options
CEEED ... ...
Product Ky Ot [Prograniies oides | SMAR T Technologe SMART Spne 2030

R — Picke: This cpsion i oy used during st rmtallation of the product

For Teachers
[v] [rerisl SMAAT Syne Teacher

For Admnndrabors

[ fretal SMART Spne Clams List Sorver

[] trertal DAAAT Sprc Amrmtrator Tadl

Customize the installation package using the controls in these pages.

Saving your changes

After customizing an installation package, you can save your changes as an XML file by selecting
File > Save As. When you next start SMART Install Manager, you can load the XML file by selecting
File > Open, or by opening the MSI file, and then selecting

File > Import.

B 1ip

All XML files you create or open in SMART Install Manager appear in the Modified Packages tab of
the Welcome page.

Publishing your changes as an MST file
The final step in using SMART Install Manager to customize an installation package is to publish your
changes as an MST file. Do this by selecting File > Publish, and then use the dialog box to define a
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location for and create the MST file.

B Tip

Publish the MST file in the same network location as the MSI file.

To customize the SMART Sync Teacher installation package, open the SMART Sync 2010.msi file
in SMART Install Manager (see Using SMART Install Manager on page 48), and then complete the
following procedure.

To set installation options
1. Click Installation Options.
The Installation Options page appears.

2. Inthe Installation directory box, type the path to your preferred folder for
SMART Sync software.

H nNoTE

If you don’t include this property, Windows Installer installs SMART Sync Teacher in
%PROGRAMFILES%\SMART Technologies\SMART Sync 2010.

3. Select the check boxes of the software components you want to install.
4. Click Product Key.
The Product Key page appears.

5. Inthe Product key box, type your school’s 22-character product key for SMART Sync
software.

To configure SMART Product Update
1. Click SMART Product Update (SPU) Options.
The SMART Product Update (SPU) Options page appears.
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2. Select the Install SMART Product Update check box to install SMART Product Update.

H nNoTE

SMART Product Update doesn’t check for updates to SMART Sync software. However, it
does check for updates to other installed SMART products.

3. Inthe Check for updates box, type the number of days between SMART Product Update
checks.

H NoTE

By default, SMART Product Update checks for product updates every 30 days. You can set
it to check for product updates at intervals of one to 60 days.

4. Select the Notify users about SMART product updates check box to notify the user when
product updates are available.

To specify a SMART School file
1. Click SMART School File.
The SMART School File page appears.
2. Inthe SMART School file box, type the path to the SMART School file.
OR

Click Browse, and then use the dialog box to browse to and select the SMART School file.

H nNoTE

Before you can specify the path to a SMART School file, you must install SMART Sync
Administrator Tool, and then use it to create the SMART School file.

To customize the SMART Sync Student installation package, open the SMART Sync Student.msi
filein SMART Install Manager (see Using SMART Install Manager on page 48), and then complete
the following procedures.

When customizing the SMART Sync Student installation package, you can configure the software by
using either a SyncClient.ini file or the controls in SMART Install Manager.
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To set installation options
1. Click Installation Options.
The Installation Options page appears.

2. Inthe Installation directory box, type the path to your preferred folder for
SMART Sync software.

H nNoTE

If you don’t include this property, Windows Installer installs SMART Sync Student in
%PROGRAMFILES%\SMART Technologies\SMART Sync Student.

3. Select the Install Start menu and desktop shortcuts check box to create shortcuts to
SMART Sync software in the Start menu and on the desktop.

To configure SMART Sync Student using a SyncClient.ini file
1. Click Student Configuration File.
The Student Configuration File page appears.
2. Inthe Configuration file box, type the full path and file name for the SyncClient.ini file.
OR

Click Browse, and then use the dialog box to browse to and select the SyncClient.ini file.

H nNoTE

If you've previously installed SMART Sync software, you can run the SMART Sync Student
Configuration Tool to create a SyncClient.ini file, which you can then refer to in this box.

To configure SMART Sync Student using SMART Install Manager
1. Click Interface.

The Interface page appears.
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2. Select one of the following options:

Option
Visible to students
Hidden from students

Select this option to:

Show the SMART Sync software user interface to the student.
Hide the SMART Sync software user interface from the student.

H nNoTE

If you click Hidden from students, the student won’t be able to do the following:
o Connect to a teacher by selecting his or her name from a list

o Manually start SMART Sync Student

o Manually enter an ID after starting SMART Sync Student
3. Click Startup.

The Startup page appears.
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4. Select one of the following options:

Option

Select this option to:

Allows the student to

select from a list of
available teachers

Allow the student to select a teacher from a list.
H NoTE

This option is disabled if you clicked Hidden from student in
step 2.

Automatically connects

with this Teacher ID

Connect SMART Sync software to a specific teacher through
the teacher's ID.

Type the ID in the box below the option.

Automatically connects
with this hostname or IP

address

Connect SMART Sync software to a specific teacher through
the host name or IP address.

Type the host name or IP address in the box below the option.
H NoTE

If your network uses DHCP, refer to the computer by host
name rather than by IP address.

Uses this Class List

Server hostname or IP

address

Connect SMART Sync software to a specific teacher using
SMART Sync Class List Server.

Type the host name or IP address of the SMART Sync Class
List Server computer in the box below the option.

H nNoTE

If your network uses DHCP, refer to the SMART Sync Class
List Server computer by host name rather than by IP address.

IMPORTANT

If you clicked Hidden from student in step 2 but do not provide a teacher ID, host name or
IP address in this step, the student will not be able to connect to a teacher.

5. Click Options.

The Options page appears.

6. Clearthe Start SMART Sync Student automatically check box if you don’'t want
SMART Sync Student to start when the student first logs on.

H nNoTE

This check box is disabled if you selected Hidden from student in step 2.
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7. Select the following check boxes:

10.

11.

55

Check box

Select this check box to:

Ask questions

Allow the student to ask questions through SMART Sync
Student.

Chat

Allow the student to chat with other students through SMART
Sync Student.

Submit files

Allow the student to submit files through SMART Sync Student.

Exit the Student program Allow the student to close SMART Sync Student.

H nNoTE

These check boxes aren’t visible if you clicked Hidden from student in step 2.

Click Student ID.

The Student ID page appears.

Select one of the following options:

Option

Select this option to:

Student Controlled

Allow the student to enter an ID when SMART Sync Student
starts.

H nNoTE

This option is disabled if you clicked Hidden from student in
step 2.

The following

Enter a specific student ID.
Type the ID in the box below the option.

Found in this Active
Directory field...

Find the student ID in an Active Directory field of the student’s
login account.

Type the Active Directory field name in the box to the right of the
option.

Anonymous

Allow the student to use SMART Sync Student without entering
anID.

Click Shared Files Folder.

The Shared Files Folder page appears.

Select one of the following options:

Option

Select this option to:

My Documents folder

Store files the teacher shares with the student in the My
Documents folder (Windows XP or Windows 7) or Documents
folder (Windows Vista).

Custom folder

Store files in another folder.
Type the path to the folder in the box below the option.
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Online information and support

Visit smarttech.com/support to view and download user’s guides, how-to and troubleshooting
articles, software and more.

Training

Visit smarttech.com/trainingcenter for training materials and information about our training services.

Technical support

If you experience difficulty with your SMART product, please contact your local reseller before
contacting SMART Support. Your local reseller can resolve most issues without delay.

H NoTE

To locate your local reseller, visit smarttech.com/wheretobuy.

All SMART products include online, telephone, fax and e-mail support:

Online smarttech.com/contactsupport

Telephone +1.403.228.5940 or
Toll Free 1.866.518.6791 (U.S./Canada)
(Monday to Friday, 5 a.m. —6 p.m. Mountain Time)

Fax +1.403.806.1256

E-mail support@smarttech.com
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Address

Switchboard

Fax

E-mail

SMART Technologies
3636 Research Road NW
Calgary, AB T2L 1Y1
CANADA

+1.403.228.5940 or
Toll Free 1.866.518.6791 (U.S./Canada)

+1.403.228.2500

info@smarttech.com

To help us serve you, register online at smarttech.com/registration.
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